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Hello and welcome to the very first issue 
of total, our brand new, absolutely free, 

emagazine. A member of the editorial team at 
3dtotal will put together a carefully selected 

collection of tutorial content each issue, 
covering both traditional and digital painting, 
as well 3D techniques and processes to get 

the creative juices flowing, helping you expand 
and develop your own artistic skill set.

In the very first issue you will be treated to an 
introduction to the 3dtotal team, and an insight 

into some of the projects we are working on 
at the moment. Additionally you can enjoy 

some of our sci-fi themed articles and tutorials 
which we hope will help take your own work to 

the next step.

So sit back and enjoy the first of many issues 
of total magazine.

Simon Morse
Editor
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In this section of total magazine we will be 
telling you a little about our company as well 
as showing you what we have been up to 
recently. As this is the very first issue of total 
I thought I would start by introducing you to 
the 3dtotal team and letting you know a little 
about the many other projects we’re working 
on at the moment.

Rather than doing a boring and to the point 
“meet the team” article, I thought it would 
be fun to introduce the people that make 
3dtotal as amazing as it is (yes that’s right, 
“amazing”) by sharing some of the pictures 
from our recent team building day. So really 
I should start at the top with Tom Greenway. 

Tom (01) set up 3dtotal in 1999 and has 
taken it from being a simple 3D resource 
site to a globally recognized website and 
publisher of quality art books and tools. 
Maybe it’s because such a large part of Tom’s 

life has been spent at a computer, but Tom 
likes nothing more than to retreat to his small 
woodland and work on his rather impressive 
tree house. We had a great day in Tom’s wood 
and made our own bows and arrows which 
was a lot of fun.

In the foreground you can see (from the left) 
3 formidable archers (02) Adam, Rob and 
Marisa. Adam is our Publishing Co-ordinator 
which means that he keeps the whole 
operation ticking over. Adam is also a talented 
fiction writer so if you like apocalyptic horror, 
check out his book The Risen by Adam J. 
Smith. 

Rob is an enigma. He spends most of his 
day hidden away sending parcels around the 
globe. No-one knows how old he is. There’s a 
chance Rob is actually 200 years old found 
the fountain of youth. This seems like the only 
obvious conclusion to the mystery.

01                                 

Interesting facts 

about Tom: Tom 

carves a mean 

wooden spoon and 

is a pretty gifted 

flower arranger
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Don’t mess with 

the best coz the 

best don’t mess
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I’m not sure it’s that 

kind of horse Mel

is one of the newest members of the 3dtotal 
family and is a great member of our design 
team. Every day Joe hosts a mini-quiz and 
keeps a tally of weekly scores. He even has a 
Quiz Master jacket and tie to make the whole 
thing feel a little more authentic. It might 
sound like I’m making this up, but every day 

Joe leads a chorus of “Let’s get quizzical, 
quizzical.”

On the left is our Lead Editor and newly 
appointed Assistant Manager Mel. Mel 
always goes the extra distance to make sure 
that our books are as good as they can be and 

On the right is Marisa. Marisa is a talented 
artist and a great Editor. She manages 
Graphite magazine as well as putting together 
three books every year. Marisa is constantly 
trying to throw things at my face, specifically 
my large forehead (as she would describe 
it). Immediately after this photo she hit the 
target, by imagining it was my face.

Next you can see three more (03) of the team 
(from the right this time – just to keep you on 
your toes) we have Imi, Joe and Mel. Imi is 
our Lead Designer and does an outstanding 
job of making our books look great. She also 
keeps the other two designers Matt and Joe 
in check (those little rascals). Imi is the one 
and only owner of a “full body bib” or as you 
and I would call it, a towel tucked into the neck 
of her jumper. No-one really knows why she 
needs that level of protection from her food, 
but after all this time we’ve stopped asking.
The rose between two thorns here is Joe. Joe 

keeps on top of a pretty mammoth workload. 
For someone as capable and intelligent as 
Mel it is taking a remarkable amount of time 
for her to find Tupperware that doesn’t leak 
salad dressing into her bag every day.
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04 - 08

Merry men 

and ladies

09

The full ensemble

Tristan is not only one of the nicest 
gentlemen you’re likely to meet (04), but also 
boasts an eclectic collection of psychedelic 
hats and jackets. Tristan must be at least 
twice as clever as the rest of us as he has 
four monitors and we all only have two. 
Tristan keeps the website and systems up 
and running and helps me do all the tasks on 
my computer that I struggle with, like opening 
Word and finding the “on” switch.

This cool character is Matt (05), the last 
of our graphic designers and the longest 
standing member of the 3dtotal team. Matt 
lays out our stunning quarterly magazine 
GRAPHITE and always blows me away in 
regards to how quickly he can come up with 
an amazing design. Matt is undoubtedly an 
incredibly wise man. There is nothing that 
Matt doesn’t know about 3dtotal and he 
supports the greatest football team in history, 
Manchester United. 

Next we have the second of our editors Annie 
(06). Like Marisa, Annie manages three books 

a year and our magazine Character Design 
Quarterly. Annie took to her role like a duck 
to water and now manages all her work with 
fantastic professionalism. Annie wore blue 
wellies (wellington boots) with big boggly 
eyes to the wood, which are actually her least 
conspicuous pair of shoes. There’s nothing 
that Annie doesn’t know about EastEnders, 
she has recently taken up roller skating and 
she was very graceful when I accidentally 
broke her mug. Sorry Annie.

Our Advertising Sales Manager Becky is 
the newest member of the 3dtotal team 
(07). Becky is excellent at coming up with 
advertising solutions and has come to 
3dtotal with some really cool ideas. Becky is 
from the south of the UK and has proven to be 
a valuable resource when planning holidays 
to Cornwall.

Last but not least you have me. My name 
is Simon and I’m the Studio Manager (08). 
I’m here to make sure everything happens 
when it’s supposed to and that we continue 

to make quality books and products. My job 
is made much easier because everyone else 
is so good at theirs. I genuinely feel lucky 
to be working at 3dtotal and continue to be 
amazed at the team’s patience with me. My 
favorite pastimes include spending time with 
my family, art, football, and humor that only a 
very small group of people find funny.

I hope you enjoyed that little introduction to 
the team (09) and what we all do. We all feel 
very lucky to work somewhere that we can be 
creative and where we can fuel a community 
that appreciates our products, and we look 
forward to doing more of the same in the 
future.
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What are we working on
at the moment? 
We are constantly working on the next issue 
of a magazine or putting together the pages 
of our latest book. 3dtotal is a constant hive 
of activity so in this short section I thought 
I would show you one or two of the projects 
we are working on at the moment.

Anatomy Figures
A few months back we ran another 
successful Kickstarter project to launch 
some new anatomy figures that we’re really 
excited about. Our anatomy figure range has 
been really well received as it continues to 
be a useful resource to help artists portray 
accurate human anatomy. We now have piles 
of boxes full of anatomy figures (10), being 
shipped around the globe and hopefully 
putting a smile on the face of our backers.

The tall chap you can see in the middle here  
(10) is our new adaptable male figure which 

allows you to change the pose of the model 
as well as see muscle structure in more detail. 
This is our biggest anatomy reference to date 
and will prove to be a versatile reference for 
anyone working on characters. You can also 
see the two new planar head models here 
which are a great reference when you are 
working on the structure of a face. 

Magazines
Long time 3dtotal fans will be more than 
familiar with our two magazines 2dartist and 
3dcreative. Sadly each of those magazines 
became a victim to piracy. However we love 
to make the best out of a bad thing, so from 
out of the ashes of our two digital magazines 
arose 2 quarterly print magazines that we are 
really proud of. In this image (12) you can 
see the fantastic cover of GRAPHITE issue 4 
which is available now. In each issue amazing 
traditional artists talk about their inspirational 
approach to creating unique concepts and 
illustrations. I can honestly say that no other 

publication has ever made me want to pick 
up my tools and create something like this 
magazine. Marisa and Matt do an amazing 
job of making each issue just as stunning (if 
not more so) than the previous issue. In issue 
4 we take a look at the breath-taking skills 
of the guys at CreatureBox, check out some 
mind-blowing inking by Richard Anderson 
and enjoy some jaw-dropping delights from 
Eduardo Vieira (in case you haven’t noticed I 
like hyphens).

Character Design Quarterly (CDQ) is riddled 
with expert advice about designing unique 
and purpose made characters for illustration, 
animation and concept art (13). As someone 
that particularly enjoys this kind of art this 
magazine is a joy to work on. The cool thing 
about CDQ is that it doesn’t just include 
creative solutions and advice, but is also full 
of industry knowledge from well respected 
studios and artists. 

Books
The most recent book we have put on pre-
order is Mythical Beasts: An artist’s field guide 
to designing fantasy creatures (14). This is a 
really exciting title where each of the 30 artists 
involved uses the description of a mythical 
creature and real world research to design a 
fantasy beast. I’ve never really closely looked 
at mythical beasts, but now I’m hooked and 
can’t wait to suggest doing volumes two, 

three and four! Keep your eye out for this one 
on pre-order in late July/August.

In conclusion 
So there you go; an overview of what we are 
up to at the moment. There’s so much I could 
add to this, but you’ve heard enough from 
me and are probably itching to look at the 
tutorials in issue 1 of total magazine. I hope 
you enjoy our new magazine and feel like you 

10

All boxed up and 

ready to go!
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Our new anatomy 

figures with an 

existing model in the 

background for scale
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Issue 04 of our 

beautiful magazine 

GRAPHITE 
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Issue 01 of Character 

Design Quarterly
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A small taster of 

what you might 

expect from 

our Mythical 

Beasts book

know a little more about the people behind 
3dtotal. Before I go though I wanted to deliver 
one final dramatic bombshell to leave you on 
the edge of your seat and begging for more; 

3DTOTAL IS BEING RE-DESIGNED AND OUR 
NEW SITE WILL BE LAUNCHED LATER THIS 
YEAR (drops the mic)!

To get information about any of the products you’ve seen visit our shop – shop.3dtotal.com10 11

12 13

14

https://www.3dtotal.com/?utm_medium=3dtotal_link&utm_source=total_issue_01&utm_campaign=total_magazine

https://www.3dtotal.com/?utm_medium=3dtotal_link&utm_source=total_issue_01&utm_campaign=total_magazine

https://shop.3dtotal.com/?utm_medium=page08_shop_link&utm_source=total_issue_01&utm_campaign=total_magazine



Anatomical reference figures

Whether you use pencil and paper, paintbrushes, 
clay, ZBrush, Maya, 3ds Max, or Photoshop, 
3dtotal’s anatomical reference figures are 
invaluable if you want to understand the form 
and structure of the human body. All figures are 
cast in neutral gray resin to make the variation in 

the surfaces easy to discern. 

The range includes:

Male half-skin/half-écorché

Female half-skin/half-écorché

Male écorché

Female écorché

Male skin

Female skin

Male planar

Female planar

Adaptable male

Male half-basic/half-complex planar bust 

Female half-basic/half-complex planar bust

shop.3dtotal.com
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By Alexander Iglesias
Web: flyingdebris.deviantart.com

Designing a
Repair Droid

Featured in:

Designing 
Droids eBook

Available at shop.3dtotal.com
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Hello, my name is Alex Iglesias and I am a 
mech art addict! In this tutorial we’re going 
to go through the process of designing and 
illustrating a repair droid.

Now when it comes to the basics of mech 
design, the first thing you want to ask yourself 
is, “What is this mech/droid supposed to do 
and how is it going to do it?” In the case of this 
design, the “what” was part of the assignment 
and that was repairs. Now, to different people 
the idea of some sort of repair droid means 
different things. 

Concept
Some people might picture some sort of 
anthropomorphic robot handyman; others 
might imagine spiderbots working in unison, 
or maybe some kind of ambulatory multi-tool. 
In the case of this design, I pictured some 
sort of battlefield engineer unit that follows 
around combat units and patches them up, or 
tries to salvage them if they are blasted apart. 
With that approach in mind I began making 
sketches exploring that idea. 

At this point the idea of the “how” began to 
form. It would fix up/interact with other droids 

bit helped this too. Also I put more of a lean 
into the repair bot’s pose, which added a little 
more implied weight to its form.

Defining shapes
After I was happy with the sketch I started 
defining the originally ambiguous shape from 
the sketch into more specific surfaces. I also 
began experimenting with certain dark areas 
and aspects of lighting. However, it was still 
fairly crude and more clean-up work and 
refinement continued well into the process of 
this piece (02). 

Immediately after I was comfortable with the 
basic details and layout, I added a flat brown 

via long spider-like appendages ending in 
pincers, tools, cutters, and so on. After a small 
bit of exploration of silhouettes, I decided 
to depict the repair droid mid-work, sifting 
through wreckage while its allies converge 
on an off-screen fight in the background (01).

As I looked at the initial sketch it became 
apparent that there were a few things that 
didn’t quite sit right in the image – it felt 
too static and lacked energy. The solution I 
found was to flip, warp and distort areas of 
the image to make things appear just a little 
bit more dynamic. Tilting the horizon a little 

tone over the whole image and added some 
rudimentary shadows, in order to provide a 
bit of a background tone as I continued the 
rendering process (03).

Adding color
I began to add some color gradients to start 
establishing the dusty atmosphere of the 
piece, and started to clean up the design 
of the droid itself. I also began to establish 
the forms of the background vehicles at this 
point. I really wanted to give the impression 
of some large mobilization consisting of a 
combined arms force. Part of the reason for 
this was to give the viewer some rough idea 
of what the blasted wreckage at the repair 

droid’s feet might have looked like (04).

For some reason I really enjoy bright yellow 
color schemes on vehicles. So in the case of 
this repair droid, to help distinguish it from the 
combat units and to make it associated with 
industrial equipment, I applied an Overlay 
layer of a bright, school bus yellow! I didn’t 
add this yellow to the areas I wanted to leave 
as exposed metal. I also painted in some dust 
to show the movement of all of the droids in 
the scene (05). 

02

01

04

03

05

https://www.3dtotal.com/?utm_medium=3dtotal_link&utm_source=total_issue_01&utm_campaign=total_magazine

https://www.3dtotal.com/?utm_medium=3dtotal_link&utm_source=total_issue_01&utm_campaign=total_magazine



1 5  |  t o t a l  0 1 D e s i g n i n g  a  R e p a i r  D r o i d  |  1 6

Adding contrast
I wanted to differentiate areas further, help 
diversify the color scheme, and add even 
more of an industrial flavor, so I made several 
surfaces much darker and unpainted. The 
caution strip was also added to several areas 
as it’s a classic, easily identifiable motif that 
helps cement the industrial aspect further. 
In order to make the machine appear more 
used, areas of chipping and fading in the 
paint were added. Experimentation with the 
color scheme via the Hue and Saturation tool 
also caused the overall colors to become 
brighter and more vibrant (06).

After taking another look at the image, I 
found that the colors were actually a bit too 
saturated now and the machine was still 
not looking worn enough! More weathering 
was added using grunge brushes I had, in 
addition to some smaller clean-ups and 
edits. The overall effect made the machine 
appear a little darker and its paint job a bit 
more mottled. At this point I also felt that 
one of the surfaces was woefully empty and 
decided to add a number decal for fun. Areas 
that were meant to be bare metal were also 
considerably more defined at this stage in the 
progress (07).

Foreground
The mech’s details were pretty much nailed 
down at this point, so it was necessary to 
move on to other aspects of the piece. In this 
case the foreground. First and foremost I had 
to come up with some convincing dirt! Using 
the underlying color plus a texture, I found I 
was able to create exactly what I was looking 
for (08). After that I had to edit the overall 
silhouette of the scattered debris, cleaning 
up the shapes and adding form to them. For 
added form and detail I used various metal 
textures and grunge brushes at low opacity 
to get the necessary amounts of metal 
noise. The fires were essentially tweaked 
and modified textures that I applied using 
the Lighter Color layer style, which really 
gives that sort of “flames in broad daylight 
appearance.”

06

07 08

https://www.3dtotal.com/?utm_medium=3dtotal_link&utm_source=total_issue_01&utm_campaign=total_magazine

https://www.3dtotal.com/?utm_medium=3dtotal_link&utm_source=total_issue_01&utm_campaign=total_magazine



1 7  |  t o t a l  0 1 D e s i g n i n g  a  R e p a i r  D r o i d  |  1 8

With the foreground and focus point where 
I wanted them it was time to finish off the 
background. The attack units took a bit of 
work, namely in cleaning up or adjusting 
the individual silhouettes. But as they were 
relatively small, implied detail went a long 
way here. 

Background
The giant weapon platforms in the far distance 
also got some measure of refinement and 
definition, but not too much as it would not 
be conducive to conveying their far away 
distance and immense size. 

My personal favorite part of the background 
though was the creation of the artillery muzzle 
flash on the far left giant mech platform. 
Essentially it was just a sketched blob shape 
that had some tweaked fire textures dropped 

in it. The texture was then merged, set to 
Lighter Color and dropped in opacity (09). 

The end result was something relatively 
minor, but it goes a long way to showing how 
much dust and distance there is between 
it and the viewer. A considerable amount 
of hand-drawn smoke clouds were also 
involved.

The image was now looking pretty solid 
to me, but it was still a bit too clean and 
flat. Something had to be done about that. 
Using some gray on a Color layer I opted 
to desaturate certain areas of the image 
to make the repair droid seem a bit more 
worn. Also, finding the bare metal surfaces 
themselves a little lacking, I decided to clean 
them up and contrast them a bit more, so as 
to make those parts stand out. 

Final atmosphere
Although the image up to now looked dusty, 
it didn’t really look that acrid, scorched 
earth, type of dusty. I really wanted that 
“carcinogens in the air” type of smoke factor 
in my image. Using some textures of overcast 
skies and various clouds, and some tweaking 
of layer types and opacities, I managed to get 
the amount of smoke desired (10).

Lastly it came down to adjusting the general 
color, hue, saturation and contrasts to finally 
make the image pop, plus a few general color 
overlays and gradients. After a fair bit of 
tweaking the various image aspects I finally 
reached a point were I was satisfied with 
it. The air in the image looked so thick that 
it could have been cut with a knife. Also the 
mech looked well-used and sturdy, which 
fitted the image perfectly.
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Modeling a 
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In this tutorial I am going to explain how 
I brought the repair droid to life in 3D, and 
what kind of things we should take into 
account when modeling and texturing a 
character. This droid was designed by a 2D 
artist and I was provided with drawings from 
different angles.

I made the complete model using 3ds Max 
2009, and used V-Ray for the lighting and 
Photoshop CS4 for the textures.

Base mesh
First of all, I took my time analyzing the 
concept, shapes, proportions, and his attitude. 
I asked myself, where is he? What are all 
those arms and what do they do? I ended up 
making a little resume of his existence in time 
and space, which is a good way of developing 
an in-depth understanding of the concept of a 
character (01). Once I had all this information 
in my mind I was ready to start creating him! 
In 3ds Max I imported the front, side, and 
back drawings first as references and started 
building piece by piece. I didn’t pay attention 
to details at this stage; I only focused on the 
main shapes and proportions.

I am going to show how I made the head area. 
I created a sphere for his little head according 
to the reference, and then proceeded to 
make all the pieces around his neck and 
placed them correctly. I used lots of edge 
connections, extrusions, and bevels; with 
only these tools I made almost everything I 
needed for the whole model (02).

The same method was applied to make the 
leg. I created the main objects and placed 
them by following the references. Simple 
cylinders were enough to show the joints. 

Remember that at this point, it was not 
important to add too much detail; the goal 
here was to end up with a strong silhouette 
for the character (03).

Following this process with each area of the 
robot, I completed the full model (04 – 05).
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When the torso’s turn came, I found it a little 
difficult to arrange the pieces in the correct 
way without deforming the figure of the body, 
so I made a quick mesh simulating his torso 
and put the respective pieces over it (06).

Since the drawing does not show some areas 
of his back very clearly, I designed them 
myself while maintaining his style. I also 
took advantage of some empty areas where 
I could include cables. When I had finished 
the entire base model of the droid, I moved 
forward to the next step, which was adding 
the detail (07).

Note: Aiming for simplicity, creating general 
shapes and establishing a strong silhouette 
were the goals in this section.

Detailing
Once the base mesh was done, it was time 
to make the details of every single piece. I 

wanted the droid to look real and the more 
details it had the more real it would look. But 
what kinds of details should I make? 

Well, this is when references took an 
important role in the creative process. By 
looking at reference photos of machines, 

I was able to find interesting details that 
I applied to my model, like lines to divide 
pieces or small holes – basically, details that 
would suggest the droid had been made in 
some kind of industrial process.

The details were made using more tools than 
the basic shapes, including Edge Extrusion, 
Chamfers, Bridge, Weld, and so on.

Now I am going to explain how I made some 
of the principal pieces. Let’s start with the one 
over the head. I took the base mesh I’d done 
for it and started by connecting some edges 
in the areas I needed to. I then suggested the 
semicircular holes that were on the concept 
by selecting the respective faces and applying 
inset and arraying vertices. 

After that, I selected all the faces of the edge 
of the piece, applied an inset and extruded 
inward. At this moment I took some time to 
organize the mesh, making better topology, 
and I then proceeded to select the faces on 
the top and side, making a small inset and 
bevel to get the effect I saw in the concept. 
Finally, to add the TurboSmooth modifier 
I selected some edges and applied a very 
small chamfer for the modifier to work 
properly (08).

The majority of the pieces were made 
using this method and applying the same 
techniques (09).
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Next I am going to explain some tricks I used 
in specific situations. For example, one of 
the pieces in the torso had some elongated 
holes. To make these, I started by building 
some kind of pattern with the shape of the 
hole. I then made some cuts in the respective 
faces of the piece, following this pattern, 

and with a combination of extruding edges, 
arraying and welding vertices, I completed 
the entire section. 

Finally, I selected the desired faces to extrude 
them and applied a small chamfer to some 
edges to give the piece a smoother finish. I 

didn’t use TurboSmooth for this one; I got the 
result I wanted by using polygon smoothing 
groups (10). I used this trick for a good 
number of pieces (11).

Since the style of this particular droid has 
a sharp finish, I only used TurboSmooth on 
some specific pieces (like the shoulders and 
big joints); for the rest of them I used polygon 
smoothing groups. Using smoothing groups 
can be very tricky. I generally set them to about 
30 or 35 and press the Auto Smooth button, 
but I really see the effect when rendering, so 
I can always change any particular group 
manually in case I need it (12).

Texturing
After the droid was completely detailed and 
finished, I continued to unwrap and pose it. 
I divided the droid into two maps of 4096 
x 4096 each. The way to divide the maps 
is up to you; sometimes its better doing it 
by materials or colors, and sometimes its 
better by sections. In this case I decided 
to divide the maps by sections. I included 
the leg and all the arms in one map, and 
the full torso in another one. I also baked 

an Ambient Occlusion map to have a better 
contrast (13). The first thing I always do at 
the very beginning of the texturing process 
is to set up the main colors. I painted yellow 
and gray in different layers and made some 
adjustments using Brightness, Contrast, and 
Color Balance until I got the desired result. 
At that point I also included the “burnt_05b” 
map from the Total Textures V19 – Destroyed 
and Damaged DVD to give him a nice metal 
feeling (14).

10 11

14

13

12
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Since he is a repair droid I saw him in a 
war, fixing the fallen units (as shown in the 
concept image). So, he has some damage 
because of the battles nearby, but most of all, 
he has a lot of rust and dust as he is not well 
preserved. 

To achieve a general rusted and scratched 
look, in my repertoire of maps I found one 
called “RustScratches0033_3_S” from CG 
Textures, which worked perfectly for this 
purpose. I made some adjustments to the 
map, like changing the blending options, 
brightness and contrast, and then applied it.

To give a final touch to the rust I made a 
new layer filled with a red color (similar to 
the one in the scratches) and masked in 
the “tile01medium_15” and “tile02heavy14” 
alphas from the Total Textures V05:R2 – 
Dirt & Graffiti DVD in areas where there 
would probably have been more corrosion. 
Concluding the dirt session, I added dust by 
masking the “PlasterWhiteDirty0105_2_S” 
map from CG Textures with a Dry brush; again 
making the necessary adjustments to make 
the map look like dust (15).

Finishing the diffuse, I added the text and 
the hazard bars “symbol_18” from the Total 

Textures V07:R2 – Sci-fi DVD, and applied 
a trick to integrate these symbols into the 
texture, which was modifying the underlying 
Blending layer (16). Using blue I also painted 
small bulbs and his eyes, but in addition to 

this I added some lights near the bulbs in 3ds 
Max to get a better result.

Talking a little about the lighting (17), I would 
like to thank my partner Eduardo Balestrini 

for helping me with this project by making 
the shaders and illumination for the robot. He 
used a global HDRi with a key light and some 
fills around. He also, very kindly, sculpted the 
terrain for me.

15

16

17
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To finish, I rendered out some passes with 
V-Ray for post-production (18a – f), then in 
Photoshop I played with blending modes and 
adjustments until I got the final image.

Conclusion
The repair droid has a very particular design, 
so it was very interesting to do. I really enjoyed 
making it, so I hope you like it and I hope this 

tutorial has offered you some useful tips for 
your future projects. Thank you very much for 
taking the time to read this tutorial.

18f

18d

18b

18e

18c

18a
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Sicarius
By Viacheslav Gedich

We see a mass of images like 

this one submitted to our 

gallery every week, but every 

now and then an artist really 

gets it spot on and comes out 

with something original and 

well presented. The design and 

execution of this is great.
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First come first served
By Ben Filliat | Web: instagram.com/benwoohaah

It is often the case (particularly with 3D artists) 

that the final presentation of a sculpt is given too 

little thought. Here’s a great example of a nice, 

clean, simple sculpt that is presented really well.

Free Hugs
By Marcos de Moraes Sampaio | Web: noton.com.br

What can I say, I’m a softy! I’ve always been partial 

to a nicely executed cartoon image. This image 

is consistent in its design, engages well with the 

viewer, and quite simply put a smile on my face.
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Sci-fi Environment
By Munkhjin Otgonbayar | Web: facebook.com/illiminato.forza

These sci-fi corridors are swiftly becoming a fashionable topic 

for 3D artists and we see a lot of them submitted to the gallery. 

I particularly liked this one because of its contrasting clean 

and tarnished surfaces which give it bags of character.
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Blind Hunters
Near right

By Alexey Egorov

Web: behance.net/Air-66

Alexey is a regular contributor to our gallery 

and has mastered the art of generating edgy 

digital paintings. Within seconds of looking 

at this your thinking about whom these 

characters are and what are they hunting? It’s 

a great way of engaging with your audience.

Her Eventual Hesitation
Far right

By Marek Denko

Web: marekdenko.net

I’ve been involved with 3dtotal for over 

6 years and still firmly believe no-one 

can tackle a complex 3D scene as well as 

Marek. The textures and materials here 

are second to none. I could talk about 

how amazing this is all day long.
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The Black Opal Gang
By Manuel De Jorge

Web: nbquaternion.artstation.com

Sometimes a simple clay render can be a great 

way to present an image. The outcome of not 

being distracted by textures and materials in this 

case is that you really get to appreciate the design 

and personality present in these characters.

Click here for details

Submit
your

gallery
images!
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Skyscraper 
city

By Christopher Balaskas
Web: balaskas.artstation.com

Featured in:

Beginner's guide 
to digital painting 

in Photoshop:
Sci-fi and Fantasy

Available at shop.3dtotal.com
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A futuristic sci-fi style city demands an 
accurate use of perspective in order to 
convince the viewer to suspend their 
disbelief, engage with the subject matter, 
and let their imagination run free. A good 
knowledge of perspective, and its rules, is 
a critical foundation skill for an artist, so 
I encourage you to explore and study the 
great wealth of information and tutorials 
available either for free or low-cost on the 
internet or in books dedicated to the subject. 
If perspective is implemented incorrectly, it’s 
often the first thing that a viewer will notice, 
and the rest of the image (no matter how 
polished or jazzed up with fancy effects it is) 
will suffer. 

In this tutorial we will go over the basics of 
setting up a two-point perspective layout 
which will serve as the guide to rendering 
a large, hi-tech urban area with ships 
whizzing about its sky. In addition, we will 
address the need to convey depth by using 
atmospheric perspective. This practice 
involves increasingly fading objects into 
the distance by reducing their contrast and 
opacity. How strongly this effect is used 
greatly determines the sense of scale and 
mood of a piece.

Finally, we will add smaller details and signs 
of life that will bring a sense of narrative, 
energy, and character to the environment. 
I feel that the strongest artworks have the 
fewest elements necessary to tell a little 
piece of a story. They let the viewer’s mind fill 
in the blanks with their own imagination. With 
all this in mind, let’s start a new illustration! 

Thumbnail sketches
Begin scribbling ideas down with small 
thumbnail sketches, around nine per page 
(01). Working at a small scale allows you 
to produce a good deal of ideas rather 
quickly without getting caught up in details. 
Use a simple square brush (which suits the 
architectural elements we want to draft) 
and focus on the relationships between 
shapes and composition. Using only four 
grayscale values and a white background 
easily establishes a sense of depth in the 
space. The last of the group immediately 
appeals to me as a place to which I could add 
human activity, so I choose this as my basic 
composition. I then select and copy it using 
the Marquee tool.

01

Small grayscale 

thumbnails allow 

you to focus on big 

strokes, shapes, 

and composition

02

Copy and paste, 

then scale up the 

image to get started

03

Set your layer 

structure logically 

to avoid wasting 

time later

“Focus on the 
relationships 
between shapes 
and composition”

Creating a new document
Since this image is going to be used for print 
medium, I create a new document at 6,000 × 
3,375 pixels at 300 dpi, which preserves the 
aspect ratio of the original sketch (which is 
16 × 9). Paste the image from your clipboard. 
It is not necessary for you to work as large 
as this, but if you decide to print your work 
later on you’ll be glad that you did! Using Edit 
> Transform, scale the pasted image up to the 
edges of the document (02).

Separating elements 
onto layers
The image is now ready to be refined into 
layers. You can repaint every element on its 
own layer above this image, or use the Magic 
Wand tool to select them. The Magic Wand 
tool is a selection tool that allows you to 
select areas of consistent color – try it on a 
photo to see how it works! You can adjust the 
Tolerance on the Options bar to dictate how 
wide the color range is that will be selected 
(03).

I use the Magic Wand tool to select each 
item. Since these are simple blocks of gray 
it is easy to click on them. Use Ctrl+X then 
Ctrl+V to cut and paste the blocks into layers, 
keeping the foreground elements on the 
top of the layer stack and the background 
elements towards the bottom. 

After the layers are created you can fill the 
background with white, and then clean up 
the edges on each layer to get rid of any 
messy pixels, filling in any gaps left from the 
cutting and pasting process as you go. Now 
you have a foreground, middle ground, and 
background on individual layers with a white 
backdrop. Your image is ready for figuring out 
the perspective grid and guides!

01

02

03
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04

Select a horizon 

line and two 

vanishing points

05

On a new layer 

use your vanishing 

points to draw a 

perspective grid

06

Shape silhouettes 

into perspective 

by erasing and 

painting with the 

grid as a guide

Establishing vanishing points
It’s time to find your horizon line. I decide to set the horizon 
low, which will direct the viewpoint upwards. This will make 
for an interesting scene full of atmosphere with a large scale 
(04). Place both the left and right vanishing points off the edge 
of the page. This will reduce the distortion created by having 
them too close together on the page. 

Don’t place the vanishing points too far out however, as this 
will flatten your perspective greatly and reduce the sense of 
depth, making the image look like it is being viewed through a 
telephoto lens. A happy medium between the two works best. 
The left sides of objects will recede towards the left vanishing 
point and the right sides to the right vanishing point.

Creating grids
The backbone of any drawing, especially one with architecture, 
is the perspective grid and layout. An easy way to set up your 
perspective grid using vanishing points out of frame is to 
create a new layer, draw a simple tick over your horizon line, 
and then draw a series of lines converging to the vanishing 
point (05). Duplicate this layer using Layer > Duplicate Layer, 
then hit Ctrl+T, right-click, and select Flip Horizontal.

Now drag the flipped vanishing point to the right by using the 
Move tool (V) and holding the Shift key until it is close to the 
right edge of the image (2). Hit Ctrl+E to flatten the two layers 
into one, and press Ctrl+T again. Holding the Alt key down, grab 
the edge of the Transform box and drag outwards until both 
of your vanishing points are out of the frame (3). Press Enter 

when you are happy with your placement; 
you’ve now completed the perspective setup 
for your image (4)! 

Add as many lines to your grids as you feel 
are necessary. The more you have, the more 
precisely you can render objects without 
guessing at the correct perspective. I should 
note that this is a very basic setup, and that 
it can get considerably more complicated. It 
pays to be as precise as possible at this stage 
of the painting as it will save you headaches 
in the clean up further down the road.

Clarifying silhouettes
Reduce the Opacity on the perspective 
guide layers down to 40% so that they are 

not distracting, yet are still visible enough, 
and begin to refine the building edges in 
accordance with the grid. Adding with a paint 
brush or subtracting with the Eraser tool 
where necessary, clarify the volumes (06). 

Make sure that you have some rounded 
forms as well as linear, square shapes for a 
pleasing variety of forms. In this manner you 
can prevent the architecture from becoming 
homogeneous in style. Take your time here 
and think about how your volumes will 
appear when lit as you clean up and edit the 
silhouettes. 

04

05

06

PRO TIP
Be an explorer
Always try new things! Experiment 
constantly with settings, layer modes, 
new brushes, and so on. Many of my 
“eureka” moments in painting have 
come while messing around like this, 
particularly with features I seldom use. 
Often you will discover a new painting 
technique by trying things you don’t 
quite understand, or never thought you 
would need to bother with. 

“Add as many lines to your grids as you feel are necessary”
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Adding the ships
Using the perspective lines to guide you, 
quickly block in silhouettes of the ships using 
very basic round and square brushes with no 
Opacity settings. Try to place your ships (and 
all elements for that matter) in a way that will 
help the eye flow around your image. Thinking 
forward in the process a bit, I am going to 
focus on the top two ships and let the third be 
less detailed, so I use a lighter gray to block 
this one in. Each ship is on its own layer, and 
I add a clipping layer to each one by creating 
a new layer, then Alt+clicking between the 
new layer and the ship’s layer. This will allow 
you to paint in some highlights, defining the 
forms without worrying about going “outside 
the lines,” so to speak (07). 

Imagine that the light is coming from above 
in the image. Paint in some white tone where 
the light would illuminate the shape using 
a soft round airbrush. Then create some 
details and panel lines by erasing out using 
a smaller hard round brush. This is a very 
quick technique to establish form in your 
silhouettes and is used quite often in concept 

art. Put simply: block-in the shape, clip a new 
layer, lay-in highlights on the new layer, then 
erase out shadow and details. Repeat this as 
often as you need to. 

Beginning rendering
This way of building up a silhouette is 
certainly not the only method to accomplish 
the rendering of an image (nor is it the one 
I always use), but it is a simple process for 
a beginner to pick up. You may find later on 
that painting in line work on another layer 
rather than erasing out is more suited to your 
style of working. With practice you’ll find 
what suits you best. Regardless, continue the 
painting of the ship silhouettes with a soft 
round brush, using the Eraser or a small hard 
brush on the details until you are happy with 
the panel lines and the level of detail on each 
ship. Occasionally add a bit to the silhouette 
layer to make corrections to the shape’s 
perspective as you go. Once you are happy 
with each ship’s look, select the clipping layer 
and press Ctrl+E to merge the highlight and 
panel layer with its parent layer (08).

By adding a slight reflective highlight towards 
the receding edges of the curved surfaces, 
the ships begin to appear more at home in 
their environment. In this image, I’m aiming 
for indirect sky light so I keep most of the 

shadows relatively soft. An irregular-shaped 
Smudge tool helps to fade hard shadows into 
soft ones which have a greater distance from 
the casting edge. Repeat this and the previous 
step on all three ships until you are satisfied 

with their appearance. Take your time; there 
are no rewards for rushing things. The more 
time you spend rendering and thinking about 
how light falls on your objects the better your 
painting will turn out.

07

Block in your silhouettes, 

painting highlights 

where the light will fall

08

Use soft round brushes 

on a clipped layer, with 

details erased or drawn 

with a small hard brush

09

Use Darken, Lighten, 

and the Smudge tool 

on clipping layers to 

define the ship further

Defining the forms
With your panel lines as a guide, you can use 
more clipping layers to define the secondary 
shapes of the ships. Using Darken and 
Lighten layers (being careful not to lose your 
lines underneath), the shapes should be 
visually separated and the crafts given more 
depth and complexity (09). 

07

08

09
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Rendering the tower
Time to start adding definition to the 
architecture in this scene! You can use the 
same process as you did for the ships, except 
that rather than using a gigantic airbrush, opt 
for the Gradient tool. Add a new layer, clip it 
to your silhouette layer, and use the Gradient 
tool to drop in a smooth transition from light 
gray to dark gray. This will give you a basic 
top-down lighting effect (10).

Using our friend the perspective grid again, 
erase the lines and tones that will define the 
volume of the dock from the clipped Gradient 
layer. You may also choose to draw with black 
on a layer above this instead. It is a little tricky 
due to the peculiar shape, but after a couple 
of tries I’m happy with the basic shape I have 
created. Now that you have a gradient giving 
you a general top-down lighting effect, and 
the lines which define the volume, you can 
merge these layers. 

By observing how light behaves in the real 
world around you, and by using those studies 
in your work, the most otherworldly scenes 
can be made believable. To render further 
you can simply add another clipping layer, 
paint in light and shadow, merge down, and 

then repeat until you are finished. Once you 
have your grids defined, and silhouettes 
and line art complete, it is just a matter of 
painting in the light and shadow of an object 
in accordance with your chosen lighting. This 
is basically the process you can use, over and 
over again, for rendering each item.

The mid-ground
and background
Now that your basic foreground structure is 
rendered to a decent level it is time to turn 
your attention to the other buildings in the 
scene. The exact same process is used here, 

their initial fill color ensures that they retain 
their relative distance in the scene. This time 
around I draw my lines on a layer above the 
clipped Gradient layer, rather than erasing 
out, using 100% black and 100% white with 
the layer’s Opacity set to 25%. Remember 
that light gets trapped in convex corners, 
and bounces onto adjacent surfaces. This is 
true of indirect, soft, and diffuse light (which 
create soft shadow, and less bounce), as 
well as direct light like the sun or a lamp 
(this generates sharper shadow and more 
bounce).

Windows and details
A great way of letting the viewer know the 
scale of any scene is by adding elements 
which they can relate to. You can do this by 
adding windows to the building on the left 
of the scene. As an easy and quick way of 
dropping these in, open a new document 
(1,000 × 1,000 pixels in this case) and use a 
simple square brush to make a rectangular 
shape on a new layer. 

With the Move tool, click and drag this layer 
while holding the Alt and Shift keys. This 
duplicates the layer, and holding the Shift key 
constrains the movement up and down, and 
side to side. Move to the side, then merge this 
new layer down. Repeat until you have a row 
of windows (12). 

Familiar objects give cues of size and distance 
to the viewer so the smaller your windows, 
the larger the scale of the structure. Repeat 
the process of duplicating and merging down 
until you have large blocks of windows for 
your building. Copy and paste the layer into 
the scene, then use Edit > Transform (Ctrl+T 
and right-click) and choose Perspective to 
distort the block with the perspective grid. 
Clipped to the building’s silhouette layer, 
erase the window layer out here and there to 
add more interest. Paint a simple reflection 
of a skyline on another clipped layer. Draw 
in panel lines to finish up. The rest of the 
buildings can then be rendered out using the 
same process.

but this time I am careful to keep the elements 
a little simpler, keeping the contrast low and 
concentrating on form over detail (11). 

In the mid-ground and background you don’t 
want to distract the viewer too much from the 
main subject, so make sure that you don’t add 
anything more complex than is present in the 
foreground. Suggesting details and elements 
rather than rendering them fully will give the 
viewer’s eyes a break in these areas. 

Making sure that your darkest feature on 
these structures doesn’t deviate too far from 

10

Use the perspective 

grid again to help 

you render the 

architecture with 

soft shadow

11

Render the 

mid-ground and 

background with 

fewer details than 

the foreground

12

Create windows 

on a new layer 

using Move, 

Transform, and your 

perspective grid

12

11

10
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Far background and sky
We will stay in grayscale for the bulk of this 
process until later. If your image looks good 
in black and white then it will be simple to 
color. It is easier to correct problems without 
color complicating things for you. Again, 
drop in a gradient with the Gradient tool, this 
time a much lighter one, using a small hard 
round brush to draw in the details. You don’t 
want to draw too many details, and they 
shouldn’t be too dark either. That way these 
buildings appear much further away than 
the rest. Remember that with atmospheric 
perspective, as an object moves further 
away from you it becomes lighter and loses 
contrast, with a little less saturation. Its color 
will also tend to shift towards the dominant 
color of the sky (13). 

I use white lines to draw outward corners, and 
a medium gray for recesses. This will help me 
to remember how the planes of objects turn 
when I come to render shadows and light. 
The same painting process as before can 
be used, but keep your painting very simple 
so as not to distract from the foreground too 
much. For the bright sky I use a custom-made 
cloud brush (you download brushes for this 
tutorial from www.3dtotalpublishing.com/
resources) and work from dark on the left to 
lighter to the right. 

Back to the tower
The tower’s structure has a decidedly retro 
feel and invokes a 1950s American Googie 
style. The idea of an old diner or pit stop in 
the slick upper levels of a massive metropolis 
interests me and provides a good subject 
contrast (new world against old), so I start 
to quickly research architecture and color 
schemes from this period (14). 

Using these designs as a jumping off point, 
add some details and elements to give the 
image a similar flavor. Some big porthole 
windows will look good, so drop in some 
simple circles with a hard round brush and 
use Transform to place them in the correct 
perspective. Then paint in some simple 
reflections. A quick search online for a neon 
font will turn up a few useful ones. I work 
up a couple signs which you can do using 
the Type tool. Go with bright colors for this, 
selecting Type > Rasterize Type Layer, and 
then place the letters using the perspective 
guide as before with Transform > Perspective 
or Transform > Distort. Little details add 
personality and a narrative to objects in your 
scene. Be careful not to get too dense with 
detail though; sprinkle it where it needs to be, 
and then suggest the rest. 

PRO TIP
Good saving habits
Save and save often. Despite newer 
versions of Photoshop being able to 
auto-save and recover files after a crash, 
sometimes the loss of ten minutes’ work 
can derail you. To be on the safe side, 
train yourself to hit Ctrl+S often. 

Also, save your files with reasonable 
names and incrementally in case you 
need to hop back a good distance on 
an image. Otherwise, good luck finding 
that image you named “asdfhjk;l.psd” 
because you were groggy at 3:00 am!

13

Create windows 

on a new layer 

using Move, 

Transform, and your 

perspective grid

14

Render the far sky 

and background 

with a lighter 

gradient

13
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Coloring and 
adjustment layers
After taking a step back from the image for a 
moment I feel that my background elements 
are a little too low contrast and bright, so 
I select each layer and adjust their Levels 
(Ctrl+L). Raising the black, and shifting the 
mid-tones to the right, and then pulling the 
white levels in a bit, corrects this (15). 

Now that the contrasts are fixed you can 
start to lay in colors on the diner by adding 
a clipped layer in Overlay mode. I choose to 
work with a coral pink and sea-foam green on 
the diner as those were popular colors in the 
1950s and they naturally complement each 
other. You can use the same clipping process 
as you did for the ships, and then paint in 
colors. Use Overlay, Soft Light, and Vivid Light 
modes now. 

Experiment with different kinds of layer 
modes to see what effect they have on your 
colors and values. At this stage I also add 
a bit of weathering and grime to the diner 
to give it that “used” look. Erasing out some 

PRO TIP
Creating custom brushes
You can create your own custom brush 
quite simply with any black and white 
image. With your newly created image 
open click on Edit > Define Brush Preset. 
Once you have done this a window will 
appear giving you the opportunity to 
name your new brush. Once you have 
done this your new brush has been 
created and is ready to use. If you look 
at your Brushes you will most likely find 
it at the bottom of your list.

This brush would be fine to use as 
stamp, but it isn’t very versatile as a 
brush yet. The next step is to click on the 
Brush tool and then select the Brushes 
Palette option. This will open a pop-up 
window: scroll down the list and find 
your new brush and click on it. Select the 
Brush Tip shape option and you can very 
easily change the spacing and angle to 
make the brush easier to use.

By choosing the other options in this 
list you can continue to customize your 
brush and make it ready for use. Have a 
go yourself!

15

Most problems with 

luminosity and value 

can be addressed 

by adjusting the 

Levels settings

16

Use adjustment 

layers to alter 

colors until you 

are happy with 

the general tone

areas of the diner’s color layer simulates 
worn and chipped paint. 

Further tweaks
On top of my layer stack I add a new layer, fill 
it with a bright blue, and set it to Color Burn 
at 10%. I decide a sunrise or sunset scheme 
will be more dramatic so this gives a blue 
cast to my scene. Above that I add a Color 
Balance adjustment layer. To do this go to 
the adjustment layer setting on your layer 
panel (the half white and half black circle) or 
follow Layer > New Adjustment Layer > Color 
Balance to quickly push the image in the 
correct direction. Set the adjustment layer 
to Shadows: -100, -64, and +100; Midtones: 
-100, +34, and +100; and Highlights: +50, -5, 
and -100. Leave the “Preserve Luminosity” 
option unticked. This brings even more of a 
sky-blue cast to the scene, especially in the 
background, while also putting red and yellow 
in the brighter areas (16). 

Next you can add a Color Dodge layer and 
paint with a saturated orange to wash 
sunlight across the buildings. Use shadows 

to indicate that there are some out-of-scene 
structures. Add another layer in Multiply 
mode to the lower corners with black to keep 
attention on the central elements. 

It’s possible to tweak endlessly using 
adjustment layers. Try not to get too caught 
up in making things perfect. Get the right feel 
and then move on to the next task.

Finishing up
Finally paint a few in lights on a new Color 
Dodge layer to give life to the diner and ships. 
Add one last adjustment layer, this time a 
Photo Filter one set to Sepia at 25%, to warm 
the image up just a bit. You could keep going 
with this and add more and more detail, but 
the image will become overcrowded. 

We have covered how fundamental 
perspective is in constructing a sci-fi scene 
(or any genre of art, for that matter). However, 
the methods here certainly aren’t the only 
ones and I encourage you to develop your 
own workflow. Experiment, learn from your 
mistakes, and keep going!

15

16
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I started sketching frequently again quite 
recently, in the last year or so. Previously 
when I needed to draw or sketch something 
by hand, I had always just used plain 
sheets of paper rather than a sketchbook. 
Working on games easily removes you from 
traditional media, with digital tools being so 
accessible and easy to use. But sketching 
is something else, so I got a few different 
sketchbooks and started to sketch – mostly 
sci-fi stuff, since that is what I love most.

I re-discovered the wonders of watercolor, 
brush pens and inks, ballpoints, and the one 
and only mighty pencil. I found out that a 
sketchbook is a wonderful sidearm for your 
inner artist, since it offers a limited canvas 
and a finite number of pages, and if you use 
the right tools you easily learn to be more 

decisive with your designs and scribbles. 
Using a ballpoint gives you a confident line 
and no going back, which is perfect for 
people who worry too much about a drawing 
and don’t focus on design more.  

Using different media and forgetting about 
undos for a while is really helpful, and in 
my case really refreshed and restarted my 
artistic drive, as well as actually giving me a 
few good ideas to quickly design and explore 
concepts in different ways.

Inspiration and Ideas
I find inspiration in lots of places: current, old, 
or new machinery; advances in science and 
space; looking at photos from NASA; military 
technology; and, of course, looking at other 
peoples’ art. Artists share a lot these days – 

in some ways we are like children. You see 
someone playing with an awesome toy and 
you want one too, but not his, you want one of 
your own. Another great source of inspiration 
is books: sci-fi ones, classic or new, it doesn’t 
matter – there are worlds inside that no one 
knows for sure how they look.

Materials
As I already mentioned, I like to try different 
materials and tools and also different 
combinations of them, such as watercolor, 
pencil, colored water-based pencils, a brush 
pen, gouache, ballpoint pen, and black and 
gray markers. I use a few brushes that have 
water compartments within them because 
it’s easier to carry them this way. 

01

Military Land 

Vehicle. A practice in 

perspective drawing. 

Something more 

light-hearted and 

a bit cartoony is a 

breath of fresh air 

once in a while.

02

Digital sketches. 

When you seem to 

favor a scribble from 

your sketchbook, 

you can always 

explore it further 

digitally to see 

where it takes you.

My pencils differ: I mostly use 2B regular 
wooden pencils for loose sketching, a fat 
mechanical HB pencil, and a few different 
sizes and softnesses of mechanical pencil 
for detailing and small sketching. Ballpoint 
pen is harder to choose; I carry a lot of them, 
mostly black and sometimes blue. 

I use two different types of paper: one is the 
watercolor grade of Moleskine and the other 
is the soft, plain paper Moleskine, which is 
better for ballpoint-pen sketches.

Sketching Techniques
I have found a few useful techniques 
for designing, some for early stages like 
thumbnailing, some for exploring silhouettes, 

and some for quick, detailed designs. 
Recently one of my favorite methods has 
been doing silhouettes in watercolor on a 
bigger scale with a large brush, then detailing 
and figuring out design within the silhouette, 
and then doing another watercolor pass to 
shade and further develop the idea. 

For thumbnail sketching I use a brush pen or 
a marker to draw small silhouettes and look 
for interesting shapes. Then I try to make 
loosely shaded quick sketches of some of the 
scribbles using a brush pen or a ballpoint and 
brush pen using only opaque shadows.

01

02
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03

This is a very old sketch, 

done on a single sheet 

of paper and lost, as can 

be expected. I got tired 

of drawing the same 

leg and broke it off.

04

Nomad. Another very 

old sketch, lost, because 

it was on a single piece 

of paper. Who doesn’t 

like post-apocalyptic 

worlds and mutants?

05

These are exploratory 

sketches for a cargo 

transport mech, done 

in different sizes and 

at different levels of 

detail. The large one is 

the furthest I’ve taken 

the design, but having 

these I can always 

go back and develop 

the design further.

PRO TIP
Sketch quickly
When sketching, try to draw 
as quickly as possible without 
worrying too much about the 
drawing and line quality. Try not 
to erase a lot and don’t over-
detail. Keep it simple – that’s 
why it’s a sketch.

03

04

05
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08

Designs derived 

from looking 

for form inside 

a watercolor 

silhouette, utilizing 

colored parts on 

occasion; they’re 

slightly refined, 

with some function, 

but still mostly a 

visual exploration. 

This technique is 

mostly suitable 

for exploring 

visual styles, not a 

particular functional 

design or a well-

described task.

07

Another watercolor 

sketch, this time 

with suggested 

environment 

and scale.

06

A few brush-pen 

sketches, nothing 

special, but a 

very easy way 

to put down lots 

of ideas quickly, 

without worrying 

about details.

06

07

08
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In this tutorial, I will lead you through my 
process of creating an appealing fantasy 
illustration. I’ll share my insights into the 
process as well as some practical advice. 
It will be mainly focused on composition, 
light, and color. By following my steps, you 
will learn how to control your artwork from 
the very beginning, to the finished piece. 
My main objective is to provide a reliable 
method that allows avoiding mistakes in 
the later steps of the process. You will also 
learn about the importance of the sketching 
and reference assembling process and how 
to maintain consistency with your design 
language.

Quick sketches
I usually start by doing series of small, quick 
sketches (thumbnails). I like to draw in the 
good old sketchbook with a pencil or a fine 
liner. The traditional analog tools are the most 
natural way for me to work on ideas in the early 
stages. I don’t feel restricted or overwhelmed 
by any software, shortcuts, lag or anything 
else - just pure, streamlined thoughts laid 
down directly on paper. The addition of too 
much technology like tablets and software 
could slow me down unnecessarily using up 
my time and energy. At this stage, I have no 
need of using any adjustment layers or even 
Ctrl+Z (01). 

Such rough doodles allow me to check 
out various solutions (like composition) 
quite quickly without bothering myself with 
unimportant details. Usually, I’ll do several to 
a dozen of aforementioned sketches before 
proceeding to next stage. Further parts of the 
process will require a lot of work, so it’s better 
to be sure what about what I want to achieve 
from the very beginning.

References
Once I’ve got a clear idea for the illustrations, 
I’m going for a reference hunt. At first, I just 
collect as much content as I can. I do a solid 
and wide-ranging search, as I’m trying to cover 
all the elements and aspects of the artwork, 
not only items but light and color references 

as well. It’s an organic process combined with 
more sketching when a new idea is ignited by 
a fresh find. When I find something cool that 
hasn’t necessarily crossed my mind earlier, 
but fits the feeling I’m aiming for, I will try to 
incorporate it into the initial sketch. It’s still 
early in the process to make a lot of changes, 
and since I’m operating with rough and quick 
drawings, I’m not losing any important and 
time-consuming work.

Value study
Creating strong values is an essential step 
(02). You can establish composition and 
contrast without worrying about the color 
for now. Block in all the crucial elements to 
have a good foundation that will hold the 
consistency of your artwork in place as you 
progress. If your illustration works at this 
stage, you can be almost sure it will also 
work at the end. Try hard to make this step 
as good as you can. Take your time and don’t 
rush forward if you’re not fully satisfied with 
it. Solid values are critical and will almost 
always guarantee a comfortable work 
load to the very end, without unnecessary 
troubleshooting along the way.

01

Initial sketches are 

only meant to help 

you come up with 

the idea. They can 

be ugly as long you 

can read them

02

Solid value is like 

a spine to every 

painting. Take the 

time to come up 

with strong values. 

And keep it simple

03

Having fairly solid 

sketch will help you 

to paint better all the 

elements. Drawing 

is understanding

Proper sketch
First I create a Levels Adjustment Layer over 
my value study layer. I decrease the black end 
of the graph in Levels to lower the contrast 
and brighten the layer with my values (03). 
Next, I create a new layer over it and call it 
“Proper Sketch.” This layer’s purpose is to 
create a more detailed sketch over what 
I already have. Now I can carefully push 
the design of the whole thing with greater 
accuracy and much more attention to detail. 

At this point I keep developing the initial idea 
without major changes the core of it. It should 
enrich the basic sketch and not change 
the main course. I build up the complexity 
of forms based on the set of references I 
collected before. I’m trying out my options; 
what works the best regarding the design I’m 
looking for? What does not? I consider this 
step complete at the point where I’m certain 
that I have enough information for further 
work.

01
02

03
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04

I recommend doing 

simple color studies 

to set up mood 

and light before 

you go for any 

heavy rendering. It 

will save you a lot 

of trouble later

05

When I don’t 

understand 

something, I draw 

it. I don’t like going 

to fight unprepared

06

I keep my image 

small enough to 

fit on the screen. 

That way I can see 

the whole picture 

and avoid going to 

soon into details

Color study
There are two approaches that work for me at 
this stage. First one is to make a color sketch 
from scratch and the second one is colorizing 
the value study I’ve made earlier. This time I 
went with the second option (04). 

First, create a new layer with Blending Mode 
set to Color. I paint on this layer to add 
colors to value study below it. It’s a relatively 
simple task at this point because the values 
are already defined and adding colors to a 
well-done value block is a fairly manageable 
process. Additionally, I use Color Balance and 
HSB sliders (if you feel more comfortable 
with some other sliders, you can go with 
them as well) with the support of Lasso Tool 
for selection of specific areas for better color 
control. 

Finally, I start painting roughly, especially over 
the areas that require a bit more precision 
and refinement. In this case, I already knew at 

the beginning that I wanted to have a sunset 
scenario in my painting, with the last beams 
of saturated light illuminating the character’s 
figure, while the fallen robot is left in the 
shadow, catching bits of the faint overcast 
light from the dark, blue sky. Classic move 
and it’s always effective. Sometimes there’s 
no need to reinvent the wheel, to tell the story 
properly. Reach for the tools that work best.

Additional designs
When I feel like the design of elements in the 
picture still need some figuring out, I spend 
extra time doing supplementary sketches, 
with a purpose of exploring various parts 
of the artwork (05). I like to know what I’m 
painting because it always pays off and 
saves a lot of time later on. I tend to make 
these sketches, even if a lot of the elements 
are barely visible in the final image. This gives 
me is more design confidence and a better 
understanding of the subject I’m dealing with. 
It also allows me to pick the best option from 

a pool of various designs, instead of forcing 
myself to go with the first idea that pops up.

Painting (finally!)
I usually start painting with more broad 
strokes to avoid getting into small things too 
early, and then as I go on, I slowly get into 
more detail. I constantly keep my focus on 
looking at the whole picture, trying to avoid 
concentrating on one little part for too long. 
And when I say it, I mean it. Literally. I work 
zoomed out, I do not enlarge the image (like 
on the screenshot), and I very rarely zoom in, 
if ever (06). 

Avoiding close-ups prevent me from going 
into unnecessary details and help to keep a 
healthy workflow. Going from bigger shapes 
to smaller ones will let you keep better control 
of the image and save you a lot of time later 
on.

04
05

06
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Unexpected changes
Every once in a while, despite the careful 
process of planning out the whole painting, 
I tend to break my rules and change some 
parts of the image later in the process. In 
this case, while going through the references 
(Orientalist paintings mostly), I realized 
that, instead of a fantasy style warrior boy 
in a dynamic pose, what I’m aiming at is 
something more dignified and classy - 
something that some egoistic monarch 
would hang on his wall in his palace; a proud 
portrait depicting richness, splendor, and 
accomplishments; one of those paintings 
that are supposed to make an impression on 
visiting guests and build an aura of nobility 
and power in the room (07).

Detail time
If you thoroughly followed all the previous 
steps, at this point, you should have a pretty 
solid image. What it needs now is major 
polishing up, as well as adding a few details. 
In this case, I have to remember to put my 
main focus on the character, because that’s 
where the focal area is. He plays the lead role 
in this painting, and it’s crucial to put some 
extra work on him. I can leave the other parts of the picture 

painted loosely to some extent, so the 
viewer’s eyes stay focused on the most 
important parts of the image. This is another 
essential tool in the bag that allows you to 
control the viewer’s attention, supports the 
narrative and lets the viewer’s eyes rest in the 
areas with less information (08). 

Images with equally distributed detail density 
throughout the image have a high risk of 
being uninteresting or chaotic. Use contrast 
when managing the detail placement. Create 
visual groups of detailed and less crowded 
areas to make it instantly readable for eyes.

Tribal motifs
The leading design inspiration for this image 
is African art and culture. The idea for robot’s 
design has originated from African patterns, 
masks, and wooden statues. A cohesive 
design language fundamentally supports 

building subtle back stories and bonds the 
world of the image together. By incorporating 
this layer of concept, I can suggest that this 
illustration is an integral part of a larger, rich 

world, and what the viewer is seeing, is only 
a small part of a vast universe. It inspires 
curiosity and makes the mind hungry for 
more (09).

PRO TIP
Simple shapes
The composition can be broken 
down into basic shapes. 
Triangles, circles, squares. Try to 
simplify your value study to the 
possibly simplest shapes and 
see if it’s interesting. Maybe there 
is something you can tweak? If 
you struggle with simplification 
of your image, it might mean 
that your composition is overly 
complicated or your focal point 
isn’t strong enough. Experiment 
with this technique to learn more 
about composition and layout.

07

There is never too 

late to change 

something. If you 

truly feel that it’s 

the right thing to 

do, don’t hesitate 

to kill your darlings

08

Now you can put 

your headphones 

on and work on 

the details. If you 

cautiously followed 

the solid plan before, 

then now it’s time to 

take a benefit of it

09

Establish a 

backstory with 

details and make the 

world believable

07

08

09
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Painting the background
It’s time to proceed to the substantial part 
of working on the sky and clouds in the 
background. I have to keep it in my mind to 
maintain the high contrast in the area around 
the character. Since the mood and effect are 
the priority for this illustration, I don’t hesitate 
to make it slightly theatrical at the cost of the 
loss of a little realism. The character needs to 
pop out and be, in this case almost literally, 
in the spotlight. If an area of the image is 
important, make sure to give contrast of 
some sort. It can be executed through a value 
contrast or a color contrast. You can also use 
sharp and soft edges or high and low detail 
range for the same purpose. Be creative and 
always use choose your tools in favor of the 
story for better effect (10).

Texture noise
Photo textures are a great and efficient way, 
regarding time and effort, to create a random 
noise suggesting detail in the image. In this 
case, I used it to visually enrich the pile of 
metal scrap under the defeated giant robot. 
For this purpose, I’ve closely searched for 
photographs with metal junk parts in it, like 
car wrecking yard pictures. Then I placed the 
photo texture in a layer with Blending Mode 
set to Overlay or Lighten/Darken (experiment 
with different modes at will, but these three 
work sufficiently most of the time). Next, I turn 
on the Layer Mask and carefully uncover the 
areas of it with a soft brush, while patiently 
looking for the best result (11).

Character details
I’ve incorporated a tribal motif into the sword. 
I’m focusing on putting in and refining more 
details as I go on, adding some texture 
and pattern variety to materials, as well as 
enhancing the design with the addition of 
ornaments. I want to make the character as 
visually rich as possible. The more refined 
the fabrics and jewelry, the better. It will 
substantially strengthen the noble warrior 
king vibe I’m aiming at (12). 

Extra content and information will add up to 
the character’s back story. The references, 
I’d gathered at the beginning of the process, 
are now strongly contributing to my workflow, 
essentially supplementing my design 
choices, as it allows me to stay true to the 
African tribal inspirations. Consistency in 
the design language is critical for achieving 
a believable result. All the design ingredients 
should harmoniously match each other, 
creating a visual dish with depth and punch 
to it, while still maintaining its core taste and 
inspiration. By thoughtful reference studying, 
I allow myself to make better design choices.

Almost done
This is the extra mile time (13). The rest of the 
time is spent mostly on refining the painting, 
connecting some loose ends and scanning 
the image for elements I could improve. I fully 
zoom out once again to check out the whole 
piece and to see how it presents in thumbnail 
size at this stage. It allows me to determine if 
my values are still on point and if my image 
preserved its readability. I’m comparing the 
almost finished image with my initial value 
and color sketches, to make double sure I 
haven’t missed anything during the process.

PRO TIP
Flip the image
I constantly flip my image horizontally while painting. That way it’s much easier to keep a 
fresh look at the painting and avoid a lot of compositional mistakes. I recommend setting 
up a keyboard shortcut for it in Photoshop as I did because it just makes it super fast to 
do the checking at all times. And while we’re at it, why not try flipping it vertically every 
once in a while? 10

While working on details, remember to 

not loose focus on the whole picture

11

By using textures wisely, you can significantly 

speed up your work. But do not overuse it. 

It’s easy to spoil the picture with unnecessary 

visual information, making it chaotic

12

The main character is the major 

subject of the image, so we put 

more detail and richness into it

13

Don’t forget about final touches. 

Take this extra mile to make it as 

good as you possibly can

10

11

12

13
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Extra tweaks
Now, when I have my finished painting, the last 
thing I like to do is make some subtle color 
and brightness tweaks, using Adjustment 
Layers and Camera Raw filter. I also display 
my work on the second monitor to double-
check the way it presents in different settings. 
It more or less simulates the way most of the 
people, the audience, will view my work. My 
second monitor is not calibrated and has a 
lower grade display, compared to my Cintiq, 
so it works well for that purpose. If you do not 
have a double display setup, try checking your 
work on your mobile or tablet and prepare a 
version that looks possibly best on those 
various devices.

Right

The finished image 

© Artur Sadlos
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